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In This Guide...

This guide describes how to use the Agilent CytoGenomics
1.5 software to run workflows and display reports and
aberrations. The functions described in this guide are
typically performed by users with an assigned role of
“Technician.” However, tasks described in this guide are
available to users with an assigned role of “Technician,”
“Scientist,” or “Administrator.”

1 Getting Started

This chapter gives an overview of the tasks required for
running workflows to extract or import and analyze samples
and display reports and aberrations.

2 Running and Monitoring Workflows

This chapter describes how to select and run manual and
automated workflows. It also explains how to use the Job
Monitor to find and check the status of workflow jobs.

3 Displaying Reports and Aberrations

This chapter describes how to display the reports and
aberrations for completed workflows.

4  Reviewing and Signing Off Results

This chapter describes how to find and open analyzed
samples, make changes, add notes, and sign off the results.
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Agilent CytoGenomics 1.5 — Running CytoGenomics Analyses
User Guide

Qo1
Getting Started

Overview of Tasks for Running Workflows and Displaying Results 5
Getting Help 6

In Agilent CytoGenomics 1.5, tasks in the Analysis tab let you run
workflows that

¢ perform feature extraction
e analyze samples using selected filters and detection algorithms

e generate reports

After workflows are complete, you can

» display the results

¢ check in and out samples

e triage samples

¢ sign off samples (for users with role of Scientist or Administrator)
This chapter gives an overview of the tasks typically performed in the

Analysis tab. The chapters that follow contain step-by-step instructions
for performing those tasks.

For information on the tasks commonly performed by users with the
Administrator role, see the Installation and Administration Guide. For
information on setting up and quality review (typical tasks for the
Scientist role), see the Setup and Quality Review User Guide. For
information on windows, command ribbons, dialog boxes, and reports you
see in the Agilent CytoGenomics 1.5 program, see the Reference Guide.
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Getting Started 1
Overview of Tasks for Running Workflows and Displaying Results

Overview of Tasks for Running Workflows and Displaying
Results

The following diagram shows the main tasks performed when you run a

workflow. Details on how to perform these tasks are given in the chapters
that follow.

Manual Workflow Auto-Processing Workflow

Select a workflow to run

Start auto-processing

Select input files for the
workflow

Display sample reports

Run the workflow

Display aberrations for
multiple samples

Display workflow status

Triage samples and sign
off results

Figure 1 Typical CytoGenomics tasks for running workflows and displaying results
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1 Getting Started

Getting Help

To get help within Agilent CytoGenomics 1.5

To

Agilent CytoGenomics 1.5 has several help guides. To open a help guide,
on the right side of the Agilent CytoGenomics 1.5 tab ribbon, click the
Manuals arrow. Then select the help guide you want to display. Help
guides are opened in Adobe® Reader® software.

Help videos are also available from within the Agilent CytoGenomics 1.5
program. These short videos provide brief instructions for doing basic
tasks within Agilent CytoGenomics 1.5. To start a help video, on the right
side of the Agilent CytoGenomics 1.5 tab ribbon, click Help Videos. Then
select the video you want to watch.

contact Agilent Technical Support

Technical support is available by phone and/or e-mail message. A variety
of useful information is also available on the Agilent Technical Support
Web site.

Resource To find technical support contact information

Agilent Technical Support 1 Go to http://chem.agilent.com.
Web site 2 Select a country or area.
3 Under Quick Links, select Technical Support.
4 Select from the available links to display support information.

Contact Agilent Technical ~ Telephone: (800-227-9770)
Support by telephone or
e-mail message (United
States and Canada)

E-mail message: informatics_support@agilent.com

Contact Agilent Technical 1 Go to http://chem.agilent.com.

Support by telephone or 2 Select Contact Us.

e-mail message (foryour 3 Under Worldwide Sales and Support Phone Assistance, click to

country) select a country, and then click Go. Complete e-mail message and
telephone contact information for your country is displayed.
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Getting Started 1

To learn about Agilent products and services

To view information about the Life Sciences and Chemical Analysis
products and services that are available from Agilent, go to
www.chem.agilent.com.
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User Guide

@oe- 2
Running and Monitoring Workflows

Running Workflows Manually 10
Running Auto-Processing Workflows 16
Searching for Jobs 19

Sending Results to Cartagenia BENCH 21

In Agilent CytoGenomics 1.5, workflows are used to automate feature
extraction and/or analysis of CGH and CGH+SNP microarrays. Each
workflow contains a set of actions and parameters for analyzing and
reporting the data during the workflow. Workflows are set up by users in
your laboratory with the role of Scientist or Administrator. Once the
workflows are configured and published, users with any role can run
them.

When you run a workflow in manual mode, you start the workflow and
select the input files. When you run a workflow in auto- processing mode,
the workflow automatically picks up and uses image files as they are
placed in a designated folder by a scanner. This chapter describes how to
select and run a workflow in manual or auto-processing mode, and how
to search for and display the status of workflows.
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2 Running and Monitoring Workflows
Running Workflows Manually

Running Workflows Manually

This section describes how to select and run a workflow in manual mode.
A manual workflow extracts and/or analyzes one or many samples that
you select when you start the workflow. Each time a workflow is started,
it is assigned a Job Name and Description, which is used to track and
monitor the status of the workflow, as described later in this chapter.

The following diagram shows the steps for running a manual workflow.

Select a workflow to
run

Select the arrays orimage
files to use for the (Optional) Open image in
workflow Feature Extraction

Designate sample
attributes and references

(Describe Samples)

(Optional) Cancel the

Run the workflow workflow

(Optional) Delete the
workflow

Figure 2 Tasks for running a manual workflow
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Table 1

Running and Monitoring Workflows

Tasks for running a manual workflow

To do this task

Follow these instructions

Comments

Select a workflow to

run

In the Analysis tab, click Analyze

Under Select Workflow, select the
workflow from the list.

The program creates a job name and
description, based on the workflow
name, date, and time.

(Optional) Under Job Name, type a job
name to use for the workflow run, if
you do not want to use the default job
name.

(Optional) Under Description, type a
description for the workflow run.
Select the files to use for workflow
input. The type of files required for the
workflow are determined by the
selected workflow. See the following
sections for a description of how to
select input files for a workflow.

+ By default, the job name is the
workflow name followed by the
date and time.

* You can run published workflows
that were created by users with the
role of “Scientist” or
“Administrator.”

* If you have the role of “Scientist” or
“Administrator”, you can run a
private workflow that you created.

» The input for a workflow can be
image files (for feature extraction +
analysis workflows), extracted
feature extraction files, or files that
were already imported. The
workflow you select determines
what kind of files you must select.

+ To make the selected workflow the
default workflow for running jobs,
select Set it as default workflow
for running the Job.

Running CytoGenomics Analyses User Guide
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Table 1

Running and Monitoring Workflows

Tasks for running a manual workflow (continued)

To do this task

Follow these instructions

Comments

Select image files for the
workflow (for workflows

that extract images)

Select extracted FE files for
the workflow (for

workflows that analyze
extracted images)

1

Select a workflow to run. See Select a
workflow to run.

At the bottom of the Import Image
Files pane, click Add TIFF Image(s).
The Open dialog box appears. By
default, the folder displayed is the
default image file folder that was set
up by the Scientist.

If necessary, browse to the folder
where the microarray image (.tif) file is
located.

Select the image file, and click Open.
The Add image pack information for FE
Extraction dialog box appears.

Click Add Images.
The images appear in the Import Image
Files table.

(Optional) For each image, double-click
Image Note, and type information
about the image.

Click Next to describe samples and
start the workflow.

Select a workflow to run. See Select a
workflow to run.

In the Import FE Files pane, click Add
Arrays.

The Open dialog box appears. By
default, the folder displayed is the
default image file folder that was set
up by the Scientist or Administrator.

If necessary, browse to the folder
where the feature extracted file (.txt) is
located.

Select the file to import, and click
Open.

The selected file appears in the Import
FE Files table.

Click Next to Describe Samples and
start the workflow.

* If you select a workflow that is
designed to do feature extraction
before the analysis, you must select
image files for the workflow input.

» Forinformation on the Import Image
Files pane, see the Reference
Guide.

+ If no design exists in the database
for an image you select, you must
go to the Content tab and import the
image file first. Otherwise, you will
not be able to run the workflow.
Only users with the role of
“Scientist” or “Administrator” can
import a design.

* If you select a workflow that
imports extracted Feature
Extraction (FE) files before analysis,
you must select the extracted files
for the workflow input.

 Inorder to import an FE file in a
workflow, the design that matches
the file must be present in the
database.

12
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Table 1

Running and Monitoring Workflows

Tasks for running a manual workflow (continued)

2

To do this task

Follow these instructions

Comments

Select imported data for
the workflow (rerun

analysis)

(Optional) Add a design to

the database

1

Select a workflow to run. See Select a
workflow to run.

In the Select Imported Data pane,
under Select Design, select the design
for the imported data.

Under Select Genome Build, click to
select the build for the design.

The available arrays for the selected
design and build appear in the Array
List.

Select the array(s) you wish to analyze
with the workflow. Use the > and >>
buttons to move one or all of the arrays
to the Selected Array List. Use the <
and << buttons to remove one or all of

the arrays from the Selected Array List.

Click Next to Describe Samples and
start the workflow.

Select a workflow to run that requires
extracted FE files. See Select a
workflow to run.

Select one or more extracted FE files
to import. See Select extracted FE files
for the workflow (for workflows that
analyze extracted images).

If you selected a file without a
matching design in the database, the
Design Status will show Not Found. In
addition, the Add Designs button will
be active.

At the bottom of the workflow table,
click Add Designs.
The Open dialog box appears.

Search for the location for the design,
click to select it, and then click Open.
The Design Status for the sample
changes to Path Provided.

+ Torerun an analysis, use a workflow
that uses data that is already in the
database (imported data).

» The Add Designs function is only
available for workflows that import
already-extracted FE files.

Running CytoGenomics Analyses User Guide
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2 Running and Monitoring Workflows

Table 1

Tasks for running a manual workflow (continued)

To do this task

Follow these instructions

Comments

(Optional) Open an image
in Feature Extraction

Describe Samples

Select a workflow to run that extracts
images. See Select a workflow to run.
Add one or more Tiff images to the
workflow.

In the Import Image Files table, under
View Image in FE, click View Image.
The Feature Extraction for Cyto
program opens with the selected
image displayed.

After you select the input files for a
workflow, at the bottom of the
workflow window, click Next.

The Describe Samples pane appears.

To show or hide attributes for the
sample, click Show/Hide Attributes.
The Show/Hide Attributes dialog box
appears where you mark or clear the
attributes to display.

To select or change an attribute for a
sample, select or change it in the
column for the selected array.

For CGH+SNP arrays, select a
genotype reference, if one is not
already selected.

Click Save Changes.

To go back to the workflow window,
click <<Back.

To run the workflow, click Run.

For information how to zoom the
image and change the display
options, see the Feature Extraction
for Cyto User Guide. You can open
this guide from the Help menu in
the Feature Extraction for Cyto
program.

The Describe Samples pane shows
the samples for the current
workflow. You can show or hide
attributes for the samples in the
workflow, and select or change the
attributes.

To go back to the workflow window,
use the <<Back button. Otherwise,
you will lose the selected samples
for the workflow.

For CGH+SNP analysis, each array
must have a genotype reference
selected for the Green Sample
attribute. (Use Red Sample for
dye-flipped arrays.)

Once a file is imported or analyzed,
you can no longer change the
required sample attributes. (Array
ID, Global Display Name, Green
Sample, Red Sample, and Polarity)

14
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Table 1

Running and Monitoring Workflows 2

Tasks for running a manual workflow (continued)

To do this task

Follow these instructions

Comments

1
2
Run the workflow
3
4
1
(Optional) Cancel the
workflow
2
1
(Optional) Delete a
workflow
2

Select a workflow to run. See Select a
workflow to run.

Select one or more images or files for
the workflow input, and then click
Next.

Specify sample attributes, as required.
See Describe Samples.

At the bottom of the Analysis Describe
Samples window, click Run.

The job monitor window appears, with
the workflow and its status at the top
of the workflow list.

In the Analysis tab, click Monitor.
=
e

The workflow job monitor table
appears.

In the job monitor table, in the row for
the workflow you want to cancel, click
Cancel.

In the Analysis tab, click Monitor.

The workflow job monitor table
appears.
In the job monitor table, in the row for

the workflow you want to delete, click
Delete.

* In order to see the Describe

Samples window and run the
workflow, you first select the
required input file(s) for the
selected workflow, and then click
Next.

On 32-bit machines, if you start a
workflow while another workflow is
running, the second workflow waits
until the first is complete before it
runs.

Once a workflow has completed or
failed, the Cancel button is no
longer available.

You cannot delete a running
workflow. You must first cancel the
workflow and then delete it.

You cannot delete a completed
workflow.

Running CytoGenomics Analyses User Guide
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2 BRunning and Monitoring Workflows
Running Auto-Processing Workflows

Running Auto-Processing Workflows

Auto- processing workflows automatically extract and analyze scanned
image files as they are deposited by an Agilent scanner into a designated
folder. Before running an auto- processing workflow, the workflow must be
configured by a user with the role of “Scientist” or “Administrator.” For
information on how to configure auto- processing workflows, see the Setup
and Quality Review User Guide. This section describes how to start a
workflow in auto- processing mode.

Start auto-processing
for workflow

Workflow process

Figure 3 Overview of auto-processing workflows

The following table describes the tasks required for running an
auto- processing workflow.
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Running and Monitoring Workflows

Table 2  Tasks for running an auto-processing workflow

2

To do this task Follow these instructions

Comments

* Inthe Analysis tab, under
Auto-Processing, click the start button.

Start auto-processing

for workflow o

Images placed in the
auto-processing workflow Tiff
image input directory are processed
automatically. They are analyzed
using the default workflow selected
in the Auto-Processing Settings for
the image design. These settings
are configured by a user with the
role of Scientist or Administrator.
In order to run an auto-processing
workflow, sample information must
be available either:
in the Content tab
in one or more sample
information files (SAF) in the
configured SAF File Input
Directory
SAF files, if present in the SAF File
Input Directory, are automatically
imported by the auto-processing
workflow.
Auto-processing workflow jobs
appear in the Job Monitor window,
with Type Automated.
The auto-processing workflow
continues until the user stops the
auto-processing.

Running CytoGenomics Analyses User Guide

17



2 Running and Monitoring Workflows

Table2  Tasks for running an auto-processing workflow (continued)

To do this task Follow these instructions Comments
+ In the Analysis tab, under » When you stop an auto-processing
S . Auto-Processing, click the stop button. workflow, the sample currently in
e o process will complete before the
for workflow

workflow is stopped.

1 Inthe Analysis tab, under * When you stop auto-processing,
. Auto-Processing, click Logs. the list of auto-processing logs is
Vlew_ A list of auto-processing workflows cleared.
Auto-Processing Logs appears.

2 In a workflow row, under Action, click
View.
The auto-processing log for that
workflow appears.

3 Click Refresh to update the
information in the log.
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Running and Monitoring Workflows 2

Searching for Jobs

When a workflow is started, it is added to the jobs list in the Analysis Job
Monitor window. This window is a convenient way to see the status of all
jobs, and to find and display the results from completed workflow jobs.

Table 3 describes how you use the Job Monitor to search for and manage
workflow jobs.

Table 3  Tasks for searching for and displaying workflow jobs

To do this task Follow these instructions Comments
1 In the Analysis tab, click Monitor. + Click the Reset button to reset the
= table to display all jobs.
Search for a job
The workflow job monitor table
appears.

2 Next to Search Type, click the arrow
and select the parameter to use to
search for workflow jobs.

3 Nextto Value, click the arrow, and
select the value to match for the job
search.

OR

Type the value to match for the job
search.

4 Click Search.
The jobs that match the selected
criterion are displayed in the table.

1 In the Analysis tab, click Monitor. * You cannot delete a job whose
=] Status is Running, or Waiting. To
Delete a job = delete a running job, you must

The workflow job monitor table Cancel it first.

appears.

2 In the row for the job you want to
delete, under Actions, click Delete.

Running CytoGenomics Analyses User Guide 19



2 Running and Monitoring Workflows

Table 3  Tasks for searching for and displaying workflow jobs (continued)

To do this task Follow these instructions Comments

1 In the Analysis tab, click Monitor.
=]

The workflow job monitor table
appears.

Display the job summary

2 In the job row, under Actions, click
View.
The Job Summary is displayed.

3 (Optional) Click Save Log File.
The Save Log file dialog box opens.

a Browse to a location where you
want to save the log file.
b In File name, type the name for the
log file.
¢ Click Save.
4 To close the Job Summary, click Close.

1 In the Analysis tab, click Monitor. » Reports are opened from the

® workflow data output folders that
=l

were configured by users with a
summary The workflow job monitor table role of Scientist or Administrator.
appears.

Open a report from the job

2 In the job row, under Actions, click
View.
The Job Summary is displayed. Links
to generated reports are displayed in
blue.

3 Click the link for the report you want to
display.
The report PDF is displayed.
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Running and Monitoring Workflows 2

Sending Results to Cartagenia BENCH

You can send analyzed samples to send to Cartagenia BENCH, if you have
a valid Cartagenia BENCH account. Samples are sent to Cartagenia
BENCH automatically as part of the workflow, or are sent manually using
Analysis > Partners > Cartagenia BENCH.

The following are required in order to send results to Cartagenia BENCH:

¢ The Agilent CytoGenomics program must be configured in Config >
Partners to send data to Cartagenia BENCH with a valid user name and
password.

* The Agilent CytoGenomics program must be configured in Config >
Partners to send one or more reports to Cartagenia BENCH.

¢ (For automated transfer of data to Cartagenia BENCH) The workflow
must be configured to send data to Cartagenia BENCH.

¢ The workflow must generate the same reports as those selected in
Config > Partners for Cartagenia BENCH.

* The design build for the data must be supported by Cartagenia.
In order to configure Agilent CytoGenomics for Cartagenia data transfer,
you must have a user role of Scientist or Administrator. For information

on how to configure Cartagenia BENCH, see the Setup and Quality
Review User Guide.
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2 Running and Monitoring Workflows

Table4  Tasks for sending data to Cartagenia BENCH

To do this task Follow these instructions Comments

1 Configure the workflow to send datato + In order to configure workflows and

Cartagenia BENCH. (For details, see Cartagenia BENCH data transfer,
Send data to Cartagenia the Setup and Quality Review User your user role must be
BENCH as part of a Guide.) Administrator or Scientist.
workflow 2 Make sure the workflow is configured + Users with any role can start a
to generate the same reports as those workflow in manual or
in Config > Partners for Cartagenia auto-processing mode.
BENCH.

3 Make sure the data is of a design build
that is supported by Cartagenia
BENCH (for example, hg(18)).

4 Start the workflow run, either
manually or with auto-processing.
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Table 4

Running and Monitoring Workflows

Tasks for sending data to Cartagenia BENCH (continued)

2

To do this task

Follow these instructions

Comments

Search for samples to

send to Cartagenia

1 Inthe Analysis tab, click Partners.
The Cartagenia BENCH tab appears.

2 Under Search Criteria, next to Search,

select Sent Status, Sign-off Date, or
Attributes.
3 For Sent Status,

OR

Next to Operator, select a logical
operator to apply to the value.
Next to Value, select the upload
status to which the operator is
applied for the search.

For Sign-off Date,

OR

Next to Operator, select a logical
operator to apply to the date.
Next to Value, select the date to
which the operator is applied for
the search.

For Attributes,

Next to Attribute Name, click the
arrow and select a sample
attribute to use for the search.
Next to Operator. select a logical
operator to apply to the selected
attribute.

Next to Value, click the arrow and
select an attribute value to which
the operator is applied for the
search.

4 Click Search.
The samples that match the search
criteria are displayed in the table.

Click Reset to set the search
parameters to the default settings.
To remove the results of a search
from the table, click Clear Results.

Running CytoGenomics Analyses User Guide
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Table 4

Running and Monitoring Workflows

Tasks for sending data to Cartagenia BENCH (continued)

To do this task

Follow these instructions

Comments

Send sample results to
Cartagenia BENCH

manually

Search for samples sent
successfully or with

errors

1

Search for the samples you want to
send to Cartagenia BENCH, as
described in Search for samples to
send to Cartagenia BENCH, above.

In the sample list, under Select, select
the samples you wish to send to
Cartagenia BENCH.

Click Send Now.

The Upload Status dialog box appears
that shows the status of the upload
task.

For workflows that failed, the reason
for the failure is displayed.

In the Analysis tab, click Partners.
The Cartagenia BENCH tab appears.
Under Search Criteria, next to Search,

click the arrow and select Sent Status.

Next to Operator, the only option for
Sent Status is “=".

Next to Value, click the arrow and
select Sent Successfully, or Error.
A list of the samples that were sent
successfully or those that were not
sent and generated errors are
displayed.

+ To send a single sample, click Send
Now in its Upload Status.

+ Although the results of a search
include all samples that match the
criteria, only samples that
generated the configured reports for
Cartagenia BENCH are sent.

 Ifanerroroccurs, the Upload Status
shows “Error”. Click Error to show
the Cartagenia BENCH Log Record
Status Error dialog box with details
of the error.

24
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Displaying Aberrations 31

This chapter gives instructions on how to display reports and aberration

results after workflow analyses are completed.
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3 Displaying Reports and Aberrations
Searching for Analyzed Samples

Searching for Analyzed Samples

In order to display reports or analysis results, you must first search for

the samples you want to show. You set up and search for samples at the
top of the window that appears when you click Report or Multi Sample
on the Analysis command ribbon. The following diagram gives an overview
of how to search for analyzed samples in the Report or View Multi Sample
windows.

Select the search type

Set up the search criteria (Optional) Save the

or select a query search as a query

Run the query or search
for samples

Figure 4 Searching for workflows

The following table gives instructions on how to set up searches and
queries for finding analyzed samples.
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Table b

Displaying Reports and Aberrations 3

Tasks for setting up queries and searching for samples

To do this task

Follow these instructions

Comments

1

Set up a simple search

Set up and run an

Advanced Search

In the Analysis command ribbon, click
Report E
or '_

click Multi Sample 7 = .

Next to Search Typei]s%lect Simple
Search.

Next to String Search, type a string of
text or characters to search for.

Click Run.

The samples that contain the string
are displayed in the table.

In the Analysis command ribbon, click
Report |-_
or \_=

click Multi Sample

o &
B
BE-3

Next to Search Type, select Advanced
Search.

Under Sample Attribute, click the
arrow and select one of the available
attributes to use for the search.
Select Is in range or Matches Value.
If you select Is in range, under Range,
type a start and stop value. The
program searches for any value of the
attribute that falls within that range.
OR

If you select Matches Value, under
Attribute Value, type the value or text
you want to match to the sample
attribute, or (depending on the
selected attribute) select a value from
the list presented.

Click Add.
The criterion is added to the
Conditions for the query.

+ To clear the results of your search,

click Clear Results at the bottom of
the window.

By default, the program displays the
last 10 samples with cyto reports or
analyzed results.

Is in range or Matches Value are
available depending on the sample
attribute you select for an Advanced
Search.

Logical Operation of AND will match
samples only if both conditions are
true. Logical Operation of OR will
match samples if any of the conditions
are true.

To remove all conditions for a query
and start again, click Clear
Conditions.

To clear the results of your search,
click Clear Results at the bottom of
the window.
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Table b

Displaying Reports and Aberrations

Tasks for setting up queries and searching for samples (continued)

To do this task

Follow these instructions

Comments

Save a search query

Run a saved search query

7

(Optional) Under Logical Operation,
click the arrow and select the logic to
apply for the next condition.
Perform step 3 through step 6 until
all conditions are set up.
Click Execute to run the search.
Samples that match the search appear
in the table.

Set up a search query. See Set up and
run an Advanced Search, above.

Click Save Query to save the query
conditions.

The Input dialog box appears.

Type a name for the query.
Click OK.

In the Analysis command ribbon, click

Report |-_
or \__

click Multi Sample © o .

=)

Next to Search Type, click the arrow
and select Query Search.

Next to Select Query, click the arrow
and select the query you want to run.
Under the conditions table, click
Execute.

The program runs the query and
displays a list of the samples that meet
the query conditions.

+ A default query, “Last 10 records,”
displays the 10 most recent
workflows.

« Custom queries are created in the
Config tab. You can also save the
conditions you set up as an
Advanced Search as a query. See
Save a search query.

+ To clear the results of your search,
click Clear Results at the bottom of
the window.
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Displaying Cyto Reports

Displaying Cyto Reports

After a workflow is completed, you can search for a sample and display
the cyto report that was created for that sample. The diagram below

shows the steps you use to search for a sample and display its cyto
report.

In the Report window, For information on how to search
Search for analyzed for samples, see

on page 26

Select sample record to
display

Display cyto report

Figure 5 Displaying cyto reports

The table below shows how to display cyto reports for analyzed workflow
samples.
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To display cyto reports

The tasks in this section show you how to display cyto reports for samples
in a completed workflow.

Table 6  Tasks for displaying reports

To do this task Follow these instructions Comments
1 Inthe Analysis tab, click Report. « Triage reports (sign off reports) are
2 Search for samples. See “Searching available only for samples that were
Display cyto report for fc:)r Analyzed Samples” on page 26, ;lgn.ed of(: and have a Status of
selected sample above. eviewed.

The search returns only samples for + From within the Manage Cyto
which a cyto report exists. Report dialog box, you can move

3 In the Table View, under Select, mark through report pages, ma!<e
the workflow sample for which you changes to gdltable text fields,
want to display the cyto report. export, or print the report. For more
OR information, see the Reference

Guide.

In Genomic View, under Select, mark
the box next to the sample depicted in
the genomic view of the samples.

4 At the bottom of the window, click
View Report.
The View Report dialog box appears.

5 Under Select Report, click the arrow,
and select the report you want to
display (if more than one cyto report
exists for the sample).

6 Click OK.

The Manage Cyto Report dialog box
appears with the selected report
displayed.
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Displaying Aberrations

After a workflow is completed, you can search for samples and display the
aberrations in the View Aberrations window. In the View Aberrations
window, extracted data and analysis results are tabulated and displayed
next to depictions of the genome, selected chromosome, and selected genes
of the species whose array data you are analyzing. Unlike the Triage View,
in the View Aberrations window you can open more than one sample and
display aberrations overlaid or side-by-side for comparison. In addition,
you can create differential aberration, graphical penetrance, or graphical
interval penetrance summaries. For more information about the View
Aberrations window and its features, see the Reference Guide.

The following flowchart shows the steps you use to search for analyzed
samples and display the results in the View Aberrations window.
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3 Displaying Reports and Aberrations
Displaying Aberrations

Search for and select (Optional) Display
samples Genome View for samples

(Optional) Change
viewing preferences
Show aberrations for
selected samples

(Optional) Set up and
display differential
aberrations

(Optional) Display
probe-based graphical
penetrance summary

(Optional) Display
graphical intervals
summary

(Optional) Generate
Genotype Reference File

(Optional) Search for
gene or genomic location

Figure 6 Displaying aberrations for analyzed samples

32 Running CytoGenomics Analyses User Guide



Displaying Reports and Aberrations 3

To display aberrations

The following table gives instructions on how to display aberrations within
the View Aberrations window.

Table 7  Tasks for displaying aberration results

To do this task

Follow these instructions

Comments

Search for samples

(Optional) Display
Genome View for samples

1

In the command ribbon of the Analysis
tab, click Multi Sample oE.
E-E

Search for the sample(s) of interest.
For instructions, see “Searching for
Analyzed Samples” on page 26.

Alist of samples that match the search
conditions appear in the Table View.

In the command ribbon of the Analysis
tab, click Multi Sample oE.
E-E

Search for samples to display. For
instructions, see “Searching for
Analyzed Samples” on page 26.

Alist of samples that match the search
conditions appear in the Table View.

Click the Genomic View tab.
A graphical display of all samples that
meet the search conditions appears.
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Table 7  Tasks for displaying aberration results (continued)

To do this task Follow these instructions Comments

1 Inthe command ribbon of the Analysis + For information on the items

tab, click Multi Sample oE. displayed in the View Aberrations
Show aberrations for ERE| window, and the View Preferences
selected samples 2 Search for the sample(s) of interest. options, see the Reference Guide.

For instructions, see “Searching for
Analyzed Samples” on page 26.

A list of samples that match the search
conditions appear in the Table View.

3 Inthe Table View or Genomic View,
under Select, mark the workflow
samples for which you want to display
aberrations.

4 At the bottom of the Analysis window,
click View Aberrations.

The View Aberrations window appears
with the results for the selected
samples.

1 Open one or more samples in the View « For information on the items

Aberrations window. See Show displayed in the View Aberrations
(Optional) Change aberrations for selected samples, window, and the View Preferences
viewing preferences above. options, see the Reference Guide.

2 In the View Aberrations window, click
Settings
e

The View Preferences dialog box
appears.

3 Inthe View Preferences dialog box,
select the items you want to display,
and select other viewing preferences.
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Table 7

Displaying Reports and Aberrations

Tasks for displaying aberration results (continued)

3

To do this task

Follow these instructions

Comments

1

(Optional) Generate
Genotype Reference File

Open one or more samples in the View
Aberrations window. See Show
aberrations for selected samples,
above.

In the command ribbon, click SNP.

The Generating Genotype Reference
File dialog box is displayed.

In the Generating Genotype Reference
Files dialog box, select the sample(s)
to include in the genotype reference
file.

Under Input Parameters, type a
Confidence Threshold.

Under Input Parameters, select a Level
of confidence.

Click Browse and select a location to
save the new genotype reference file.
Click OK to generate the new genotype
reference file.

The file is saved in the specified
location, with the name
GenotypeReference_<Date>_<Design
> <Build>.txt.

+ If you have a reference sample that
is not genotyped, this creates a
genotype reference for that sample
using the Agilent-provided or
known genotype references
available in the database. The
genotype calls generated using the
known genotype reference are
used, along with a user-supplied
confidence threshold and level, to
generate a genotype reference file.
This “custom” genotype reference
file can then be imported to the
database, and used to analyze
additional CGH+SNP microarrays.

» In order to generate a genotype
reference file, the Red Sample field
for each microarray (Green for
dye-flipped,) must contain the
unknown reference sample name. A
validated genotype reference must
be selected in the other sample
channel.
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Table 7

Displaying Reports and Aberrations

Tasks for displaying aberration results (continued)

To do this task

Follow these instructions

Comments

(Optional) Create a custom

track

1

Open an analyzed sample in Triage

View or the View Aberrations window.

See Show aberrations for selected
samples, above.

Right- click anywhere within the log
ratio plot area in Gene View, then
click Create Track.

The Create Track dialog box appears.
See “Create Track” on page 304.

In the dialog box, set the Name,

Description and Color.

In the dialog box,

a Select User Defined.

b Under Chromosome, select the
chromosome for the track.

¢ Under Start and Stop, type the
start and stop of the region for the
new track.

d Under Select Track Source, click
Aberration Results.

OR, to generate a track for the entire

gene

a Select For complete gene view.

b Under Select Track Source, click
Aberration Results.

OR, to generate a track for current the

region defined by the cursor

a Select For aberrant region below
cursor.

b Under Chromosome, select the
chromosome for the track.

¢ Under Start and Stop, type the
start and stop of the region for the
new track.

d Under Select Track Source, click
Aberration Results.

Click OK.

» When you create a track, you create
a list of the genes in a contiguous
chromosomal region that you
select.

* You can turn on and off the display
of tracks in the Gene View and in
Reports from the Track Settings
dialog box. See the Reference Guide
for information on the Track
Settings dialog box.

* You can also create a custom track
from a query in Config > Tracks >
Create Track From Query. For more
information, see the Setup and
Quality Review User Guide.
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Tasks for displaying aberration results (continued)

To do this task

Follow these instructions

Comments

1

(Optional) Create a signal

intensity bar chart

(Optional) Display track in

UCSC browser

Open an analyzed sample in Triage
View or the View Aberrations window.
See Show aberrations for selected
samples, above.

Right- click anywhere within the log
ratio plot area in Gene View, then click
Show Intensity Bar Charts.

The Create Signal Bar Chart dialog box
appears.

Under Set Chromosome Start-Stop,
select the region to use for creating
the bar chart. Choices include a
user-defined region, the complete
gene view, or for the current region
selected by the cursor.

Click OK.

A Median Signal Intensity bar chart is
created showing red and green signal

intensities for all selected microarrays.

Open an analyzed sample in Triage
View or the View Aberrations window.
See Show aberrations for selected
samples, above.

Right-click Gene View, and click Show
in UCSC.

The View coordinates in UCSC
browser dialog box appears.

Complete the dialog box with the track
parameters, and click OK.

The UCSC Browser appears, if you are
connected to the Internet. You may
need to enable pop-ups or set other
preferences on the UCSC Web site;
see the browser help for information.

A signal bar chart is a histogram

that displays the median signal
intensities in a genomic region of
selected Agilent arrays.

If you have more than one sample
open in the View Aberrations
window, a bar chart is created for all
selected arrays.

For more information on the Create
Signal Bar Chart dialog box, see the
Reference Guide.

For information on opening
analyzed samples in Triage View,
see“Tasks for Reviewing and
Signing Off Results” on page 48.
For more information on the View
Aberrations window, see the
Reference Guide.
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Table 7  Tasks for displaying aberration results (continued)

To do this task Follow these instructions

Comments

1 Open an analyzed sample in Triage
View or the View Aberrations window.
See Show aberrations for selected
samples, above.

2 Right-click anywhere within the log
ratio plot area in Gene View, and click
Track Settings.

The Track Settings dialog box appears.

(Optional) Change how
tracks are displayed

4 Click OK.

1 Open an analyzed sample in Triage
View or the View Aberrations window.
See Show aberrations for selected
samples, above.

2 0Onthe command ribbon, click Go to.
The Go to Gene/Genomic location
dialog box appears.

(Optional) Search for
gene or genomic location

3 Under RefSeq by Symbol, select a gene
to search for.
OR

Under Genomic Location, select a
chromosome and then type a base
position to search for.

4 Click Go.
The program finds the gene or
genomic location in the Genomic
Viewer.

3 Select tracks and how to display them.

* For more information on the Track
Settings dialog box, see the
Reference Guide.

« It can take several seconds or more
to display the Go to Gene/Genomic
location dialog box. This is because
the program searches for all the
genes in the sample.
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To display aberration summaries

From within the View Aberrations window, you can set up and display a
variety of aberration summaries. These summaries are helpful in
comparing and evaluating aberration results from a series of samples.
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Table 8  Tasks for creating aberration summaries

To do this task Follow these instructions Comments

1 Openone or more samples in the View * You must select at least two

Aberrations window. See Show samples in order to perform
(Optional) Set up and aberrations for selected samples, on differential aberration.
display differential page 32. + Differential aberration analysis
aberrations 2 Inthe View Aberrations window, click reveals aberrations that are

significantly different in different
samples. After you assign one or
The Differential Aberration Setup more arrays to each of two groups,
dialog box appears. the program evaluates the
differences in the detected
aberrations between the groups.

Aberration. |L\

3 Below the diagram for each array,
select one of these options. You must
assign at least one array to Set 1 and
one array to Set 2.

Set 1 — Assigns the array to the first
group of arrays. The program
compares the aberrations in this
group of arrays to the ones you
assign to Set 2.
Set 2 — Assigns the array to the
second group of arrays. The program
compares the aberrations in this
group of arrays to the ones you
assign to Set 1.
Ignore — The program does not
consider the array in the differential
aberration analysis.
If you have many arrays, it can be
easier to use the Define Sets dialog
box to assign the arrays to comparison
groups. To open this dialog box, click
Define Sets. For more information, see
the Reference Guide.

4 In Select Algorithm, the
HyperGeometric algorithm is selected.
It is used to evaluate the significance
of differences in the detected
aberrations between the two
comparison groups.
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Table 8  Tasks for creating aberration summaries (continued)

To do this task

Follow these instructions Comments

(Optional) Display
probe-based graphical

penetrance summary

5

Click Run.

The program evaluates the two sets of
arrays, and summarizes the
differences in the Graphical
Differential Aberration Summary

dialog box.

In the View tab, show the aberrations  * Probe penetrance plots display the
for selected samples. See Show percentage of selected arrays that
aberrations for selected samples, have an aberration at each probe
above. position on the array for the

Under Penetrance, click Probe o - selected chromosomes.

The Graphical Penetrance Summary
dialog box appears.

Mark the box(es) for the chromosomes
you want to display in the summary, or
click Select All to mark all
chromosomes. To clear all boxes, click
Deselect All.

To copy the summary to the Clipboard,
click Edit and then click Copy
Summary to Clipboard. You can then
paste the summary information in the
Clipboard into a document of your
choice.
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Table 8

Displaying Reports and Aberrations

Tasks for creating aberration summaries (continued)

To do this task

Follow these instructions

Comments

(Optional) Display
graphical intervals

summary

1

In the View tab, show the aberrations
for selected samples. See Show
aberrations for selected samples,
above.

Under Penetrance, click Interval w .

The Graphical Interval Penetrance
Summary dialog box appears.

To filter the results using an interval

filter,

a Click the arrow next to Filter, and
select an interval filter to apply.

b Click Apply Filter.
OR

To create and apply a new interval
filter,

a Click Create Filter.

b Inthe Interval Filter dialog box,
define the new filter and type a
name for it.

¢ Click Apply Filter.

* Interval penetrance plots display
the percentage of selected samples
that have an identified aberrant
region on the array. You can create
and export the plots and
tab-delimited tables of the interval
penetrance summaries, or copy the
summary to the Clipboard and then
paste it into another program or
document.

* For more information on the
Graphical Interval Penetrance
Summary dialog box, see the
Reference Guide.
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In Agilent CytoGenomics 1.5, Workflows are used to automate feature
extraction and/or analysis of CGH and CGH+SNP data. This chapter gives
instructions on how to search for workflow samples and review and sign
off the results.
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4  Reviewing and Signing Off Results
Overview of Data Review

Overview of Data Review

The following diagram gives an overview of review and sign off of
analyzed samples. Only users with the role of Scientist or Administrator
can sign off samples.

For information on how to
(Optional) Use quality tools use Quality Tools to assess
to analyze results sample quality, see the
Setup and Quality Review
User Guide

Use Triage to review and
sign off results

Use Triage to find and
display signed-off
samples with similar
intervals

Figure 7 Overview of analyzed sample review and sign off
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Using Triage View to Review and Sign Off Results

Once a workflow is completed, you display and check the analysis results
in the Triage View. The following diagram shows you what you can do in
Triage View.

Users with the role of Scientist or Administrator can open samples in Triage View and
perform all functions. Users with the role of Technician can open Triage View and perform
all functions except for Sign Off of results.
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4  Reviewing and Signing Off Results

(Optional) Search for aberrations within

Open a sample in Triage
b pletn frag selected regions

(Optional) Display CGH QC Metrics

View

(Optional) Add or change aberration calls

(Optional) Suppress aberration calls

(Optional) Add sample or aberration

Check out sample/check

in sample

(Optional) Display SNP QC Metrics

(Optional) Display sample attributes

(Optional) Display a summary of all
changes

Sign off results

(Optional) Add classifications to intervals

(Optional) Search for and display
samples with similar classification
intervals

Figure 8 Using Triage View to review and sign off results
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How results are displayed

In the Triage View, extracted data and analysis results are tabulated and
displayed along with depictions of the genome, selected chromosome, and
selected genes of the species whose array data you are analyzing.

There are four main views in the Triage View.

¢ Genome View - A graphical representation of the entire genome for the
selected species. Use this view to select the chromosome to show in the
other views.

¢ Chromosome View - A graphical representation of the selected
chromosome, displayed with cytobands and a plot area. Click or drag
the mouse to select a region to display in the Gene View.

* Gene View — A more detailed view of the chromosomal region selected
in the Chromosome View.

e Tab View - Displays CGH design annotation and log ratio data, and
CGH+SNP genotype data related to the chromosome you select in
Chromosome View. Within this table, you can search for aberrations,
and select to suppress or make changes to selected intervals, and create
interval notes. In addition, you can add or change calls.

For more information on the Triage View window features and dialog
boxes, see the Reference Guide.
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Tasks for Reviewing and Signing Off Results

The following table contains how-to instructions for using the Triage View
to review and sign off analysis results for a sample. For information on
the different views within the window, see the Reference Guide.
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Table9  Tasks for reviewing and signing off results

To do this Follow these instructions

Comments

1 In the Analysis tab, click Monitor.

2 Next to Search Type, select a criterion
to use for searching. For example,
select User to select jobs run by a
specific user.

3 Nextto Operator, select an operator to
apply to the search.

4 Nextto Value, type the value to use for
the search.

5 Click Search.

The jobs that meet the selected
criterion are displayed.

Open a sample in Triage

View

Locate the job you wish to review.

Under Actions, click Review.

8 Follow step 3 through step 5 below to
open the sample in Triage View.

OR

1 In the Analysis tab, click Review.
The Sample Search table appears. The
samples for the most recent workflow
job are displayed.

~

2 Search for a sample. See “Searching
for Analyzed Samples” on page 26.

3 Locate the desired sample in the table,
and click Analyzed, Checked Out (if
the sample is currently checked out by
you,) Checked In, or Reviewed.

4 If more than one analysis result is
available, in the Analyzed Sample
dialog box, under Select, mark to
select the name for the sample results
you wish to view.

5 Click OK.

The selected results for the sample
appear in the Triage View.

+ Samples with a Status of Analyzed
have analysis results available for
display in Triage View.

» Samples that are checked out have
a Status of Checked Out. You can
open a sample that is checked out
by another user, but you cannot
check it out or change it.

+ Samples that were changed and
checked in have a Status of
Checked In. These samples are
available for anyone to check out.

+ Samples that were signed off have a
status of Reviewed. You can display
the sample results, but you cannot
make further changes.

* Inorder to change results, you must
first Check Out the sample from the
Triage View. After you make
changes, you must Check In the
sample in order to save the
changes.
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Table9  Tasks for reviewing and signing off results (continued)

To do this

Follow these instructions

Comments

(Optional) Search for

aberrations

1 Open asample in Triage View. See
Open a sample in Triage View on
page 49.

2 In the Tab View, click Amp/Del
Intervals or LOH Intervals to select
the type of data you want to show.

3 Inthe command ribbon, click Search,

a Select Contained Within to find
aberrations within the start/stop
location.

b Next to Chromosome, click the
arrow and select the name of the
chromosome to search. For
example, select chr1 for
chromosome 1.

OR

a Select Overlapping to find
aberrations that overlap the
specified locations.

b Next to Start and Stop, type the
start and stop location of the
interval.

4 Click Next to find the next instance

that matches the criteria, or click Prev

to go to the previous instance that
matches the criteria.

The cursors in the Chromosome and
Gene views move to the location.

5 To clear the criteria search boxes, click

Clear.

+ Samples that are checked out have

a Status of Checked Out.

You can open a sample that is
checked out by another user, but
you cannot check it out or change it.
The LOH Intervals tab is only
available for CGH+SNP samples
that were analyzed using the LOH
Algorithm.
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Table9  Tasks for reviewing and signing off results (continued)
To do this Follow these instructions Comments
1 Open asample in Triage View. See + Samples that are checked out have
Open a sample in Triage View on a Status of Checked Out. You can
. page 49. open a sample that is checked out
(Optlonal_) B 2 Click Check Qut to check out the by another user, but you cannot
aberration call . .
sample. check it out or change it.
3 Inthe Tab View, click Amp/Del + The LOH Intervals tab is only
Intervals or LOH Intervals to select available for CGH+SNP samples
the type of data you want to show. that were analyzed using the LOH
4 |n the command ribbon, click Change algorithm.
Call and then click Add Call. * Click Reset to clear the boxes in the
The Add Aberration Call dialog box dialog box.
appears. + Changes made in Triage View are
5 Type the information for the aberration not saved until you click Check In or
you want to add. Sign Off. Once you click Sign Off,
6 Click the arrow next to Call, and select the record is locked to further
if the aberration is an Amplification or changes.
Deletion.
7 Click Add.
8 Click Check In.
1 Open asample in Triage View.See » Changes made in Triage View are
Open a sample in Triage View on not saved until you click Check In or
. page 49. Sign Off. Once you click Sign Off,
(e S_uppress an 2 Click Check Out to check out the the record is locked to further
aberration call
sample. changes.
3 Inthe Amp/Del Intervals or LOH
Intervals tab, under Suppress, select
the box next to each call you want to
suppress. If you change your mind,
clear the box.
4 When you are finished, click Check In
to save and check in the changes.
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Table9  Tasks for reviewing and signing off results (continued)

To do this Follow these instructions Comments
To suppress all aberration calls + Changes made in Triage View are
1 Open a sample in Triage View. See not saved until you click Check In or
(Optional) Suppress or Open a sample in Triage View on Sign Off. Once you click Sign Off,
clear suppression for all page 49. the record is locked to further
aberration calls 2 Click Check Out to check out the changes.
sample.
3 Inthe command ribbon, click Change
Call.

4 Click Suppress All.

5 In the Confirm dialog box, click Yes.

6 When you are finished, click Check In
to save and check in the changes.

To clear suppression of all aberration

calls.

1 In the command ribbon, click Change
Call.

2 Click Unsuppress All.

3 Inthe Confirm dialog box, click Yes.

4 When you are finished, click Check In
to save and check in the changes.
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Reviewing and Signing Off Results

Tasks for reviewing and signing off results (continued)

1

To do this

Follow these instructions

Comments

To suppress aberration calls for a track

1

(Optional) Suppress

aberration calls for an
entire track 2

Open a sample in Triage View. See
Open a sample in Triage View on
page 49.

Click Check Out to check out the
sample.

In the command ribbon, click Change
Call.

Click Auto Suppress.

The Auto Suppress dialog box appears.

Next to Select Track, click the arrow
and select the track that contains the
calls you want to suppress.

To suppress calls that fall in
overlapped intervals, mark Suppress
partly overlapped interval.

Click Apply.

When you are finished, click Check In
to save and check in the changes.

To clear suppression of calls in a track

1

In the command ribbon, click Change
Call.
Click Undo Suppress.

+ Forinformation on tracks, see the
Reference Guide.

+ Changes made in Triage View are
not saved until you click Check In or
Sign Off. Once you click Sign Off,
the record is locked to further
changes.
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Table 9

Tasks for reviewing and signing off results (continued)

To do this

Follow these instructions

Comments

1

(Optional) Change an 9

aberration call

(Optional) Add notes for

an aberration call

Open a sample in Triage View. See
Open a sample in Triage View on
page 49.

Click Check Out to check out the
sample.

In the Amp/Del Intervals or LOH
Intervals tab, in the row for the
aberration you want to change, click
Edit.

The Edit Aberration dialog box
appears.

Type the changes you want to make to
aberration call.

Click Apply.

When you are finished editing, click
Cancel or the red X at the upper right
corner of the dialog box to close it.
Click Check In to save and check in the
changes.

Open a sample in Triage View. See
Open a sample in Triage View on

page 49.

Click Check Out to check out the
sample.

Click the Amp/Del Intervals or LOH
Intervals tab.

In the row for the aberration you want
to add a note, click Notes.

The Notes dialog box appears.

Type the text for the note you want to
add for the aberration call.

Click Add.

The note appears in the notes table.

To include the note in the triage
sign-off report, select Show in report.
When you are finished, click Check In
to save and check in the changes.

+ Changes made in Triage View are

not saved until you click Check In or
Sign Off. Once you click Sign Off,
the record is locked to further
changes.

Intervals that have been changed
show a state of Edited.

Changes made in Triage View are
not saved until you click Check In or
Sign Off. Once you click Sign Off,
the record is locked to further
changes.
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Table9  Tasks for reviewing and signing off results (continued)

1

To do this

Follow these instructions Comments

(Optional) Add sample

notes

1 Open asample in Triage View.See + Changes made in Triage View are

Open a sample in Triage View on not saved until you click Check In or

page 49. Sign Off. Once you click Sign Off,
2 Click Check Qut to check out the the record is locked to further
sample. changes.
3 Click Sample Notes.
The Sample Notes dialog box appears.

4 Type a note you want to add for the
sample.

5 Click Add.

6 To include the note in the triage
sign-off report, select Show in report.

To add a standardized note to the sample

notes

1 Perform steps 1-3, above to open the
Sample Notes dialog box.

2 Click Add Standard Note.
The Add Standard Note dialog box
appears.

3 Under Standard Notes, click the note
you want to add to the triage sign-off
report.

4 Click Add.

5 Click 0K
The note appears in the notes table.

6 To include the note in the triage

sign-off report, select Show in report.
To add an interval or SNP Interval note to
the sample notes

1 Perform steps 1-3, above to open the
Sample Notes dialog box.

2 Click Interval Notes or SNP Interval
Notes.
A list of interval notes for the sample
appears.

3 Select Show in report for each interval
note you want to include in the triage
sign-off report.

4 Click Save.

5 Click Close to close the dialog box.
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4  Reviewing and Signing Off Results

Table 9

Tasks for reviewing and signing off results (continued)

To do this

Follow these instructions

Comments

1

(Optional) Display a
summary of all changes 2

(Optional) Display CGH
QC Metrics 2

(Optional) Display SNP
QC Metrics 2

(Optional) Search for
gene or genomic location 2

Open a sample in Triage View. See
Open a sample in Triage View on
page 49.

Click Check Out to check out the
sample.

Click Audit Trail.

The Audit Trail dialog box appears.

When you are finished, click Close to
close the dialog box.

Open a sample in Triage View. See
Open a sample in Triage View on
page 49.

On the command ribbon, click CGH QC.

The QC Metrics Table appears.

Open a sample in Triage View. See
Open a sample in Triage View on
page 49.

On the command ribbon, click SNP QC.
The SNP CN QC Metrics Table appears.

Open an analyzed sample in Triage
View window. See Open a sample in
Triage View on page 49.

On the command ribbon, click Go to.
The Go to Gene/Genomic location
dialog box appears.

Under RefSeq by Symbol, select a gene
to search for.
OR

Under Genomic Location, select a
chromosome and then type a base
position to search for.

Click Go.

The program finds the gene or
genomic location in the Genomic
Viewer.

+ The Audit Trail contains all changes

that were made to the sample results,
along with records of who checked in
and out the sample and the dates and
times.

For more information on the QC
Metrics Table, see the Reference
Guide.

SNP CN QC Metrics are displayed only
for samples that were analyzed with
SNP algorithms.

It can take several seconds or more
to display the Go to Gene/Genomic
location dialog box. This is because
the program searches for all the
genes in the sample.
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Reviewing and Signing Off Results 4

Tasks for reviewing and signing off results (continued)

To do this

Follow these instructions

Comments

1

(Optional) Display sample

attributes 2

(Optional) Add a
classification to an 2
interval

Open a sample in Triage View. See
Open a sample in Triage View on

page 49.

On the command ribbon, click Sample
Info.

The Attributes dialog box appears that
shows attributes and values.

Click Close.

Open a sample in Triage View. See
Open a sample in Triage View on

page 49.

Click Check Out to check out the
sample.

In the Tab View, click Amp/

Del Intervals or LOH Intervals.

The table of amplification and deletion
intervals or LOH intervals appears.

In the row for the interval, under
Classification, right-click the mouse
and select Add classification to this
interval.

The Add classification dialog box
appears.

Next to Select Classification, click the
arrow and select the desired
classification.

Click Add.

The selected classification appears in
the interval row.

Click Check In to save the change and
close Triage View.

+ Only sample attributes that were

marked for display in the Show/Hide
Columns dialog box are displayed. See
the Reference Guide for information
on the Show/Hide Columns dialog
box.

Sample attributes displayed in Triage
View are read-only.

Classifications that appear in the Add
classification list are those that were
created in the Config tab.

To add another annotation to the
interval, repeat the procedure.

When a classification is configured to
show as a column in Triage View, a
separate column for that classification
appears in the Table View. A number
shown in brackets [] next to the name
indicates the total number of similar
intervals found. Numbers shown in
the interval rows indicate the number
of matching similar intervals found.
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Table 9

Reviewing and Signing Off Results

Tasks for reviewing and signing off results (continued)

To do this

Follow these instructions

Comments

(Optional) Add a

classification to all
intervals

1

Open a sample in Triage View. See
Open a sample in Triage View on

page 49.

Click Check Out to check out the
sample.

In the Tab View, click Amp/

Del Intervals or LOH Intervals.

The table of amplification and deletion
intervals or LOH intervals appears.

In the row for the interval, under
Classification, right-click the mouse
and select Add classification to all
unclassified intervals.

The Add classification dialog box
appears.

Next to Select Classification, click the
arrow and select the desired
classification.

Click Add.

The selected classification appears in
the interval rows for previously
unclassified intervals.

Click Check In to save the change and
close Triage View.

+ Classifications that appear in the Add
classification list are those that were
created in the Config tab.

+ To add another classification to the
intervals, repeat the procedure.
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Table 9

Tasks for reviewing and signing off results (continued)

To do this

Follow these instructions

Comments

1 Open asample in Triage View. See
Open a sample in Triage View on

+ Classifications that appear in the
Remove classification list are those

(Optional) Remove page 49. that were created in the Config tab.
annotation from one or all 2 Click Check Out to check out the
intervals sample.

3 Inthe Tab View, click Amp/
Del Intervals or LOH Intervals.
The table of amplification and deletion
intervals or LOH intervals appears. To
remove an annotation from one
interval

a Inthe row for the interval, under
Annotation, right-click the mouse
and select Remove annotation
from this interval.

b The Remove annotation dialog box
appears.

¢ Next to Select Annotation, click
the arrow and select the desired
annotation.

d Click Remove.

e The selected annotation is
removed from the selected interval.

f Click Check In to save the change
and close Triage View.

To remove an annotation from all intervals

a Inthe row for the interval, under
Annotation, right-click the mouse
and select Remove annotation
from all intervals.

b The Remove annotation dialog box
appears.

¢ Nextto Select Annotation, click
the arrow and select the desired
annotation.

d Click Remove.

e The selected annotation is
removed from all intervals.

f Click Check In to save the changes
and close Triage View.
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Table9  Tasks for reviewing and signing off results (continued)
To do this Follow these instructions Comments
1 Open asample in Triage View. See + Once the results are signed off, the
Open a sample in Triage View on results are permanently locked, and
Sign off results page 49. cannot be changed.
2 Click Sign Off. + Only users with the role of Scientist or
The Confirm dialog box appears. Administrator can sign off results.
3 Click OK to sign off the results.
1 Open asample in Triage View. See + Only samples that were signed off are
Open a sample in Triage View on searched for similar intervals.
(Optional) Search for page 49. (Samples that are signed off have a
samples containing 2 Inthe Tab View, click Amp/Del status of Reviewed.)
similar intervals Intervals or LOH Intervals. + To open a sample that was found in
3 Locate the interval you want to use to the search, double-click in the Query
search for similar intervals. Result pane for that sample.
4 Under Classification, right-click and
select Search similar interval.
5 Click Select Classification and select
a classification to use for the search
OR
Click Select Query and select a saved
query to use for the search.
The program searches for reviewed
samples that have one or more similar
intervals and displays them in the
Gene View.
1 Open a sample in Triage View. See * The default threshold is .70. A higher
Open a sample in Triage View on number makes the search more
(Optional) Change the page 49. stringent. A lower number makes the
search threshold for 2 In the Tab View, click Amp/Del search more likely to find similar
interval search Intervals or LOH Intervals. intervals.
3 Locate the interval you want to use to
search for similar intervals.
4 Under Classification, right-click and
select Change search threshold.
The Change search threshold dialog
box appears.
5 Next to threshold, type a value to be
used for the search threshold.
6 Click Ok.
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Table9  Tasks for reviewing and signing off results (continued)

To do this

Follow these instructions

Comments

(Optional) Search for
gene information

1 Open asample in Triage View. See

Open a sample in Triage View on
page 49.

In the Tab View, click Amp/Del
Intervals or LOH Intervals.

For the interval of interest, right-click
Gene Name and select a database to
search for the gene information.

The View Gene or OMIM (if you
selected OMIM) dialog box appears.

Next to the gene of interest, click
Search to open the selected database
and locate information for the gene.
(For OMIM, click the OMIM Id.)

The selected database opens in your
browser and displays the information
for the selected gene.

+ If a gene name appears in black or

white, it does not have an OMIM Id
associated with it, and OMIM does
not appear as a database selection.

If a gene name appears in red or blue,
it does have an OMIM Id associated
with it, and OMIM appears as a
database selection. Genes displayed
in red are of morbid type.
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Table9  Tasks for reviewing and signing off results (continued)

To do this Follow these instructions Comments

1 Open asample in Triage View. See » When you create a track, you create

(Optional) Create a custom

track

Open a sample in Triage View on
page 49.

Right- click anywhere within the log
ratio plot area in Gene View, then
click Create Track.

The Create Track dialog box appears.
See “Create Track” on page 304.

In the dialog box, set the Name,

Description and Color.

In the dialog box,

a Select User Defined.

b Under Chromosome, select the
chromosome for the track.

¢ Under Start and Stop, type the
start and stop of the region for the
new track.

d Under Select Track Source, click
Aberration Results.

OR, to generate a track for the entire

gene

a Select For complete gene view.

b Under Select Track Source, click
Aberration Results.

OR, to generate a track for current the

region defined by the cursor

a Select For aberrant region below
cursor.

b Under Chromosome, select the
chromosome for the track.

¢ Under Start and Stop, type the
start and stop of the region for the
new track.

d Under Select Track Source, click
Aberration Results.

5 Click OK.

a list of the genes in a contiguous
chromosomal region that you
select.

* You can turn on and off the display
of tracks in the Gene View and in
Reports from the Track Settings
dialog box. See the Reference Guide
for information on the Track
Settings dialog box.

* You can also create a custom track
from a query in Config > Tracks >
Create Track From Query. For more
information, see the Setup and
Quality Review User Guide.
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Tasks for reviewing and signing off results (continued)

1

To do this

Follow these instructions

Comments

1

(Optional) Create a signal

intensity bar chart

(Optional) Display track in

UCSC browser

Open a sample in Triage View. See
Open a sample in Triage View on

page 49.

Right- click anywhere within the log
ratio plot area in Gene View, then click
Show Intensity Bar Charts.

The Create Signal Bar Chart dialog box
appears.

Under Set Chromosome Start-Stop,
select the region to use for creating
the bar chart. Choices include a
user-defined region, the complete
gene view, or for the current region
selected by the cursor.

Click OK.

A Median Signal Intensity bar chart is
created showing red and green signal

intensities for all selected microarrays.

Open a sample in Triage View. See
Open a sample in Triage View on

page 49.

Right-click Gene View, and click Show
in UCSC.

The View coordinates in UCSC
browser dialog box appears.

Complete the dialog box with the track
parameters, and click OK.

The UCSC Browser appears, if you are
connected to the Internet. You may
need to enable pop-ups or set other
preferences on the UCSC Web site;
see the browser help for information.

A signal bar chart is a histogram
that displays the median signal
intensities in a genomic region of
selected Agilent arrays.

* For more information on the Create
Signal Bar Chart dialog box, see the
Reference Guide.

+ For more information on the Triage
View window, see the Reference
Guide.
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Table9  Tasks for reviewing and signing off results (continued)

To do this Follow these instructions Comments
1 Open asample in Triage View. See + For more information on the Track
Open a sample in Triage View on Settings dialog box, see the
(Optional) Change how page 49. Reference Guide.

2 Right-click anywhere within the log
ratio plot area in Gene View, and click
Track Settings.

The Track Settings dialog box appears.

tracks are displayed

3 Select tracks and how to display them.
4 Click OK.
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